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Experiment 9:  Enthalpy of Formation of Magnesium 
Oxide 

Objective:  In this experiment, a simple calorimeter will be constructed and calibrated, 
and Hess' law of constant heat summation will be used to determine the enthalpy of 
formation of magnesium oxide, MgO. 

Introduction 
 
 Mark is a chemist who has just been hired by Flashbulbs Are Us, a relatively new 
company founded just three years ago in 1954.  Flashbulbs are a popular source of light 
for photographers.  In the flashbulbs manufactured by Flashbulbs are Us, magnesium foil 
is placed in an atmosphere of oxygen contained within a glass bulb.  An electric current 
(generated by a battery) is passed through the metal, and the magnesium burns with an 
intense white light.  Mark thinks there would be advantages to switching from glass to 
plastic to house the contents of the flashbulb. The flashbulbs would be easier to transport 
and less hazardous to the customers since the plastic is more difficult to break.  In 
choosing a specific plastic for the housing, he needs to select a material which can 
withstand the heat generated by the magnesium metal as it burns.  To tackle this problem, 
Mark first needs to determine how much heat is produced by the combustion of 
magnesium. 

 When magnesium is burned in oxygen, a large quantity of heat is released which 
results in a large, negative ΔH°rxn value: 

(1) Mg(s)   +   1/2 O2(g)   →   MgO(s) ; ΔH°rxn(1) = large negative number of joules, J 

The change in enthalpy of this reaction is quite difficult to measure directly by 
experiment.  However, Mark realizes that he can obtain the heat of reaction indirectly by 
measuring the enthalpies of other reactions and using Hess' law.   

 Virtually all chemical processes involve energy transfer of one type or another, 
and the branch of chemistry that explores this transfer is called thermochemistry (see 
Tro, Chapter 6).  The energy change of a reaction, symbolized by the expression ΔUrxn, 
is the sum of energy which is transferred as both heat, q, and work, w: 

  ΔUrxn = q  +  w Eq. 1 

For a reaction that occurs at constant pressure, the term enthalpy is used, which is the 
sum of the energy of all the atoms and molecules plus the work of displacing the 
environment, that is, the PV work: 

 H = U  +  PV Eq. 2 

Thus, the enthalpy change for a chemical reaction at constant pressure is defined by the 
following equation: 

 ΔHrxn = ΔUrxn  +  PΔVrxn Eq. 3 

In the case of an enthalpy change which takes place at 1 atm of pressure, we use the 
notation ΔH°rxn. 
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 In accordance with Hess' Law, enthalpy changes for chemical reactions are 
additive.  If two chemical equations are added together to form a third equation, the 
enthalpy change of the third equation, ΔH°rxn(3), is equal to the sum of ΔH°rxn(1) and 
ΔH°rxn(2).  When applying Hess' law, it is important to establish a convention for the 
signs, (+) or (–), of the enthalpy changes.  An exothermic reaction is one which releases 
energy and is assigned a negative value. An endothermic reaction is one which absorbs 
energy and is assigned a positive value.  The additive property of ΔH°rxn values will be 
applied in this experiment in order to determine the enthalpy change associated with the 
burning of magnesium metal in air. 

For the combustion of magnesium, reaction (1), one possible set of reactions is: 

(2) Mg(s)   +   2 H+(aq)  →  Mg2+(aq)   +   H2(g) ; ΔH°rxn(2) = negative number 

(3) MgO(s)   +   2 H+(aq)  →  Mg2+(aq)   +   H2O(l) ; ΔH°rxn(3) = negative number 

(4) 1/2 O2(g)   +   H2(g)  →  H2O(l) ;   ΔH°rxn(4) = negative number 

Reaction (1) is equal to reaction (2) minus reaction (3) plus reaction (4): 

 ΔH°rxn(1)  =  ΔH°rxn(2)   –   ΔH°rxn(3)   +   ΔH°rxn(4) Eq. 4 

The enthalpy of formation of liquid H2O has been measured and is given by: 

ΔH°rxn(4) = ΔH°f(H2O) = –285840 Joules/mole = –285.84 kJ/mol 

The enthalpies of reactions (2) and (3) are measurable quantities.  Heat is released by the 
addition of excess strong acid to one mole (24.3 g) of Mg, thus the quantity ΔH°rxn(2) 
will be a negative number.  Similarly, the addition of excess strong acid to one mole 
(40.3 g) of MgO will release heat, and ΔH°rxn(3) will also be negative. 

Measuring the Heat Capacity of a Calorimeter 

 Mark knows that he’ll need to use a calorimeter to measure the heat effects of the 
magnesium reactions.  A calorimeter is a reaction vessel that is well insulated in order to 
prevent heat transfer between the reaction and its surroundings.  As heat is evolved by the 
reaction inside the calorimeter, the temperature of the contents increases, and it is this 
temperature change which is measured and related to the enthalpy of the reaction.  Thus, 
all heat effects that  are observed in the calorimeter should be the result only of the ΔH° 
value of the reaction or process occurring in the calorimeter. 

 The relationship between the amount of heat absorbed by a system, Q, and the 
resulting change in temperature, ΔT = Tfinal – Tinitial, may be expressed in terms of the 
total heat capacity of the system at constant pressure, Cp: 

 Q = (Cp) ⋅ ΔT Eq. 5 

However, heat released is equal to –ΔH: 

 –ΔH = – Q = – (Cp) ⋅ ΔT Eq. 6 

 A calorimeter must be calibrated to determine its heat capacity, that is, the 
amount of heat required to raise the temperature of the calorimeter itself by one degree 
Celsius or Kelvin.  The calibration can be accomplished by carrying out a reaction which 
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has an accurately known heat of reaction and measuring its effect on the calorimeter.  
One of the most widely used reactions for this purpose is the heat of neutralization of a 
strong acid by a strong base: 

(5)  H+(aq)   +   OH–(aq)   →   H2O(l) ; ΔH°rxn(5) = negative number 

Reaction (5) releases a large amount of heat, around 57000 J/mole, therefore, 
ΔH°rxn(5) will be large and negative.  The value for ΔH°rxn(5) will vary with the 
temperature at which the reaction is carried out, and can be found in Table 1. 

 

Table 1.  Values of ΔH°rxn(5) at temperatures between 18 and 30°C 

 Temperature (°C) ΔH°rxn(5) (kJ/mol) 
18 -58.62 
19 -58.42 
20 -58.22 
21 -58.01 
22 -57.81 
23 -57.61 
24 -57.41 
25 -57.20 
26 -57.00 
27 -56.80 
28 -56.60 
29 -56.39 

 

From Table 1, take the value corresponding to the final temperature of your reaction 
solution as your ΔH°rxn(5) value. 

 In the neutralization reaction, sodium hydroxide, NaOH, will be present in an 
excess amount so that even though the solution may be contaminated with Na2CO3 (from 
the slow absorption of CO2 from the atmosphere), enough OH– will be available to react 
with all of the hydrochloric acid, HCl, added.  In this case, we call HCl the limiting 
reagent; thus, the number of moles of water formed in the neutralization is determined 
by the number of moles of HCl used.  Therefore, the actual heat released can be 
calculated from the following expression: 

 (–Q) = [ΔH°rxn(5)] ⋅ (moles of HCl) Eq. 7 

using the appropriate value of ΔH°rxn(5) from Table 1. 

 Because no calorimeter is free from heat leaks, it is possible that you will see 
some heat loss to the surroundings reflected in your data.  Figure 1 shows a temperature 
vs. time plot for a calorimetric experiment in which the reaction was exothermic. After 
the initial sharp rise in temperature when the reaction is begun (at time of mixing, t = 0 
seconds), the temperature begins to decrease due to heat loss from the calorimeter.  As 
the temperature equilibrium becomes complete, the loss becomes steady and the 
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temperature decrease linear.  Extrapolation of this linear portion of the curve back to t = 0 
seconds gives an accurate value for the maximum temperature attained, Tf, if equilibrium 
were to take place instantaneously with no thermometer lag. 

 
t=0 Time (seconds)

T (°C)

Tf

Ti

 

Figure 1. Determining Tf from a plot of temperature as a function of time. 

 

 Once Tf has been determined from the plot, it is possible to calculate the heat 
capacity of the calorimeter.  You will record the temperatures of the acid (HCl) and the 
base (NaOH) before beginning the experiment, and these will be denoted by Ta and Tb, 
respectively.  All of the heat that is liberated by the reaction will be equal to the heat 
which is absorbed by the calorimeter and its contents: 

heat liberated by reaction = heat absorbed by acid + heat absorbed by base + 
heat absorbed by calorimeter 

Each of the above terms can be expressed by experimental parameters: 

 heat liberated by the reaction (kJ) = –[ΔH°rxn(5)] ⋅ (moles of HCl) 

 heat absorbed by the acid (kJ) = (Cp, aq) ⋅ (Va) ⋅ (Tf - Ta) 

 heat absorbed by the base (kJ)  = (Cp, aq) ⋅ (Vb) ⋅ (Tf - Tb) 

 heat absorbed by the calorimeter (kJ) = (Cp, cal) ⋅ (Tf - Tb) 

where Va = mL of acid at temperature Ta, Vb = mL of base at temperature Tb and (Cp, 
aq) denotes the heat capacity of the aqueous solutions.  Substituting these expressions 
into the original equation, the following is obtained: 

–[ΔH°rxn(5)] ⋅ (moles of HCl) = (Cp, aq) ⋅ (Va) ⋅ (Tf - Ta) + (Cp, aq) ⋅ (Vb) ⋅ (Tf - Tb)  
 + (Cp, cal) ⋅ (Tf - Tb) Eq. 8 
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Solving for the heat capacity of the calorimeter, (Cp, cal):  

€ 

(Cp,cal) =
−[ΔH0rxn(5)]⋅ (moles HCl)− (Cp,aq) ⋅ (Va ) ⋅ (Tf − Ta ) − (Cp,aq) ⋅ (Vb) ⋅ (Tf − Tb)

(Tf − Tb)
 

 Eq. 9 

In Eq. 9, the quantities Ta, Tb, Tf, Va and Vb are measured experimentally, and the 
number of moles of HCl used is calculated from the known concentration and volume 
used.  To an acceptable degree of accuracy, all the aqueous solutions involved in the 
experiment are assumed to have a heat capacity, (Cp, aq), of 0.00418 kJ/mL⋅Kelvin (that 
is, 4.18 Joules are needed to raise the temperature of 1 mL of solution 1°K).  The 
calorimeter constant, (Cp, cal), can thus be calculated and used in determining enthalpy 
changes of reaction which take place within the calorimeter. 

 To measure ΔH°rxn values for reactions (2) and (3) of the magnesium oxidation 
sequence, weighed amounts of solid magnesium and solid magnesium oxide will be 
added to excess HCl.  In these cases, the solid material will be the limiting reagent.  The 
equation used to calculate the enthalpy is a simplified version of Eq. 8: 

 

€ 

−ΔH0rxn(x) =
(Cp,aq) ⋅ (Va ) ⋅ (Tf − Ta ) + (Cp,cal) ⋅ (Tf − Ta )

(number of moles of limiting reagent)
 

  Eq. 10 

The number of moles of limiting reagent is calculated from the mass of reagent weighed 
out divided by its molar mass. 

 From the values that are calculated for ΔH°rxn(2) and ΔH°rxn(3) and the given 
value for ΔH°rxn(4), the molar enthalpy of formation of solid MgO, ΔH°rxn(1), can be 
calculated using Eq. 4. 
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Procedure  (you do not need to outline instructions for using the LoggerPro software) 

 Instead of a thermometer, a temperature probe interfaced to a computer will be 
used to acquire the temperature readings in this experiment.  The temperature probe has 
an uncertainty of ±0.1°C.  These probes should not be allowed to sit in acidic or basic 
solution for longer than 10 minutes.  Rinse the probe with water immediately after each 
experiment.  Two students will use the same computer, but each student will have his/her 
own temperature probe and will obtain his/her own set of data to evaluate. Two 
temperature probes should already be plugged into the interface box and each inserted 
through a hole in the center of a cap.  Choose a probe and record the number of the 
channel into which it is plugged. You must use the same probe for all measurements. 

 To log onto the computer, type “student” for the name and type “chemistry” for 
the password, then click on Log In.  Click on the Applications folder at the bottom of 
the screen.  In the window that opens, click on the button labeled Logger Pro to open the 
Logger Pro software.  When two temperature probes are plugged into the interface box, 
the following picture should appear on the screen: 

 

 Pull down the Experiment menu and choose Data Collection….  Change the 
length of the experiment to 500 seconds.  Change the Sampling Rate to 1 samples/second.  
Click on Done.  Click once on the number at the very top of the y-axis so that a box 
appears around the number.  Type in 40 and press return. You are now ready to collect 
data. 

 Wear safety glasses at all times. 

 The computer will collect the data for both your and your partner's temperature 
probes simultaneously; therefore, you should carry out the steps of the experiment at 
approximately the same time.   
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Measuring (Cp, cal) 

 Obtain three Styrofoam cups and one cap.  Do not write directly on the cups—use 
labels.  Place 20.0 mL of standardized HCl solution (~1 M; record exact molarity written 
on the label) in one of the cups.  Calculate the number of moles of HCl which are now in 
the cup.  Rinse off the probe with distilled water, wipe it dry with a paper towel and place 
the cap through which it is inserted onto the cup that contains HCl.  Be sure the probe is 
far enough down that the tip is immersed in the solution, but that it is not touching the 
bottom of the cup.   

 Assemble a "calorimeter" by nesting the other two Styrofoam cups together (see 
Figure 2, below).  Place 30.0 mL of 1.0 M NaOH solution in your calorimeter and cover 
it with the other cap.  Place the calorimeter in a 400 mL beaker to prevent it from tipping 
over.  Wait five minutes to allow the solutions to reach thermal equilibrium. 

 Watch the temperature readings that appear below the data table (this is the 
temperature of the HCl solution).  When the temperature appears to have stabilized, 
record in your lab notebook the temperature (to the nearest tenth of a degree) of your HCl 
solution. 

 Remove the cap from the calorimeter (the nested cups).  Remove the cap and 
temperature probe from the cup that contains HCl solution, rinse the probe with distilled 
water and dry it with a paper towel.  Place this cap on the calorimeter, thus placing the 
temperature probe into the NaOH solution. 

 Click on the green button with an arrow, found at the top of the screen, to begin 
collecting data.  Allow the computer to collect readings for 10 to 12 seconds while the 
probe is in the NaOH solution.  Continue to collect the data (do not click on the red 
button) and carry out the following steps in rapid succession and at approximately 
 

Beaker

   Two nested
styrofoam cups

Temperature probe

 

Figure 2.  Construction of a calorimeter 
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the same time as your partner: 

• Remove the cap from the cup that contains HCl solution. 
• Remove the cap from the calorimeter.  Do not pull the tip of the probe out of 

the NaOH solution. 
• Add the HCl solution to the calorimeter all at once while stirring with the 

probe. 
• Replace the cap with the probe onto the calorimeter (again, make sure the 

probe is in the solution but does not touch the bottom of the cup) and swirl the 
calorimeter. 

Allow the computer to continue to collect data as you swirl the calorimeter until the 
temperature has reached its maximum and starts to decline as in Figure 1 (p. 4).  You 
should collect data for about 5 minutes.  When you have collected a sufficient amount of 
data, click on the red button to stop the data collection.  Remove the temperature probe 
from the solution in the cup and rinse it thoroughly with water. 

Important step!  Saving your data: 
• Save your data by pulling down the File menu and selecting Save As... 
• In the dialog box that appears, the word Documents should be displayed in 

the drop down menu in the middle of the box.  If it is not, scroll through the 
menu on the left, and choose Documents. 

• Next to the words Save as:, type over the word “untitled” with the name of 
your file (example: CpCalLAO).  You should include your initials in the name 
you choose. 

• Click on Save.   
• To find your file later, you will have to go to the Documents folder.  It should 

have the suffix .cmbl at the end of the file name. 

 You can now adjust the parameters on the graph.  To view just one of the plots 
(yours or your partner's), click and hold on the y-axis label.  Select Temperature 1 from 
the pop-up menu.  Click on the AutoScale button in the Toolbar which looks like this:  

  The computer will choose maximum and minimum values for the x- and y-axes 
such that the plot fills the graph completely.  If you do not like the limits for the axes that 
the computer has chosen, it is possible to change them by simply clicking once on each of 
the numbers at the ends of the axes, typing in the desired limits and pressing return.  It 
will be easier to determine the value for Tf later if the y-axis limits are whole numbers.  
Choose the maximum values to be slightly greater than the highest temperature or time 
recorded, and choose a temperature minimum that is slightly lower than the lowest 
temperature.  The minimum time recorded should be 0 seconds.   

 Adjust other graph parameters using Graph Options… found under the Options 
menu.  Be sure that a check mark appears in the box next to Connect Points, and type in 
an appropriate title for the graph in the box under Title.  Your initials should appear in 
parentheses at the end of the title (so you can identify your printout).  Click on OK.   

 To print the graph, pull down the File menu and choose Printing Options….  
Click in the box next to Print Footer to make sure a check mark appears, then type in 
your name (and a comment about the plot, if desired).  Now pull down the File menu and 
choose Print Graph… (not Print…).  Click on OK.  In the next dialog box, click on 
Print.  The printer is located in the support room.  Your name should appear at the 
bottom of the page. 
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 Repeat the procedure for adjusting and printing the second plot, this time 
selecting Temperature 2  from the y-axis  pop-up menu.  Be sure to change the title, this 
time putting the second person’s initials at the end. 

 It is possible to print the table of time and temperature readings that the computer 
collected, however, it is not necessary to do so for this experiment.  If for some reason 
you would like a printout of the data, choose Print Data Table… from the File menu. 

Measuring  ΔH°rxn(2) 

 Obtain about 120 mL of 2 M HCl in a clean, dry flask.  Rinse out the calorimeter 
cup and dry it thoroughly with a paper towel.  Clean your graduated cylinder and pre-
rinse it with the solution to be measured.  Carefully measure 50.0 mL of the 2 M HCl and 
transfer it into the calorimeter.  Replace the cap and temperature probe, making sure the 
tip is submerged in the liquid. 

 Measure 30 mm of magnesium ribbon (approximately 0.056 g), and scour it 
lightly with sandpaper to remove surface oxide.  Wind the ribbon into a loose coil so that 
it can fall completely into the calorimeter cup.  Weigh the ribbon accurately and record 
the mass.  Be sure to weigh the ribbon after you have scoured it. 

 Pull down the Experiment menu and select Store Latest Run.  Under the Data 
menu, choose Hide Data Set followed by Run 1.  You can now collect a new data set.  
Click once on the number at the end of the x-axis, type in 500 and press return.  Click 
once on the number at the bottom of the y-axis, type 0 and return, then click on the upper 
limit, type 40 and return.  Select All of the Above from the y-axis pop-up menu.  Click 
on the green button and allow the computer to collect temperature readings for 10-12 
seconds on the 2 M HCl solution in the calorimeter.  Remove the cap, and with the probe 
still in the solution, add the magnesium ribbon with stirring.  Replace the cap and swirl 
the calorimeter as the computer continues to collect data for about 5 minutes or so.  
Remove the temperature probe from the solution in the cup and rinse it thoroughly with 
water. 

 Follow the procedures given above to save, adjust, re-title and print your plot.  

Measuring ΔH°rxn(3) 

  In a small, clean, dry sample vial place 0.2 to 0.25 grams of granular magnesium 
oxide.  Record the total mass of the bottle and its contents. 

 Again, rinse and dry the calorimeter cup, add 50.0 mL of 2 M HCl and replace the 
cap and temperature probe. 

 Pull down the Experiment menu and select Store Latest Run.  Under the Data 
menu, choose Hide Data Set followed by Run 2.  Change the limits on the x-axis to 0 and 
500, and change the limits on the y-axis to 0 and 40.  Make sure both Temperatures 1 and 
2 are displayed on the y-axis, then click on the green button and allow the computer to 
collect temperature readings for 10-12 seconds on the 2 M HCl solution in the calorimeter.  
Remove the cap, and with the probe still in the solution, add the MgO solid to the HCl all 
at once.  Be careful to avoid letting the solid adhere to the walls of the cup.  Replace the 
cap and swirl the calorimeter as the computer continues to collect data for about 5 minutes 
or so. Remove the temperature probe from the solution in the cup and rinse it thoroughly 
with water. 
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 Follow the procedures given above to save, adjust, re-title and print your plot.   

 Re-weigh the empty sample vial to obtain the weight of MgO that was added. 

 Rinse the temperature probe and the cups with water before leaving the lab.  
When you are ready to leave, pull down the Logger Pro menu and choose Quit Logger 
Pro.  Pull down the Apple menu and select Logout.   

You should leave the laboratory with printouts of the three plots that you 
produced today.  However, you should also store a copy of your data file(s) using either 
www.bc.edu/myfiles or by e-mailing the file(s) to yourself (see Storing and Retrieving 
Your Lab Files on page 14 of the notebook/manual).  If you need to adjust any of your 
plots after your lab period is over, you can use the computers in the chemistry teaching 
labs when the rooms are not occupied (MWF 9:00-12:45 or TuTh 12:00-1:15). 

A note on displaying multiple data sets: 

 If you would like to view one of your earlier plots, simply pull down the Data 
menu and choose Show Data Set followed by the Run # that you wish to display.  It is 
possible to have several sets of data displayed simultaneously.  The Runs are numbered 
sequentially in the order in which they were acquired, with the most recent Run being 
called Latest.  Simply use the Hide Data Set and Show Data Set commands to view the 
desired plot or plots. You may have to re-adjust the plot display parameters (such as axes 
scales, etc.).  Use the y-axis label to display one or both temperature plots, as desired.  
Options also appear under the Data menu to delete one or more sets of data.   

 If at any point you have trouble displaying or printing the proper plot or axis limit, 
try the following:   

• Click on the y-axis label and select More…. 
• In the window that appears, scroll through the list, clicking on the boxes until 

the box(es) corresponding only to the data that you wish to display has/have a 
check mark.  Note: You do not want a check mark to appear next to Time 
anywhere in this list. 
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Calculations 

1.  Determine the Tf (±0.1°C) from your plot for Measuring (Cp, cal) by the 
extrapolation method shown in Figure 1.  Calculate the heat capacity, (Cp, cal), 
of the calorimeter using Eq. 9.  This value is usually small (less than 20 
J/Kelvin or 0.020 kJ/Kelvin).  It is such a small value that it is of the same 
order of magnitude as the experimental error; consequently, the calculation 
could yield a small negative number.  Should this be the case, simply assign 
(Cp, cal) the value of 0.0 kJ/Kelvin. 

2.  Using the plot from Measuring ΔH°rxn(2), determine Tf, and calculate 
ΔH°rxn(2) using Eq. 10. 

3.  Treat the data obtained for ΔH°rxn(3) in a similar manner by determining Tf 
and calculating ΔH°rxn(3) using Eq. 10. 

4.  Substitute the values you obtained for ΔH°rxn(2) and ΔH°rxn(3), along with the 
given value for ΔH°rxn(4), into Eq. 4 to calculate the heat of formation of 
magnesium oxide, ΔH°rxn(1) = ΔH°f(MgO). 

Questions 

1.  Comment on the effectiveness of your calorimeter.  What evidence, if any, did 
you see that indicates heat was lost from the calorimeter to the surroundings 
during the course of the experiment?  

2.  The flashbulb that Mark is attempting to modify contains 0.62 g of magnesium 
metal.   

a) Based on the heat of formation of magnesium oxide that you obtained, 
how many kJ of energy are released by the flashbulb contents?   

b)  Assume the energy released by the reaction is completely absorbed by the 
plastic.  If 10.4 g of plastic material having a specific heat of 8.7 J/g°C has 
been used to manufacture the bulb, what will be the temperature of the 
plastic after the flashbulb goes off?  Assume the bulb is at room 
temperature, 20°C, before ignition. 

3.   A student rinsed the calorimeter cup with water but did not dry it before 
determining ΔH°rxn(3); consequently, a significant amount of water was 
present in the cup before the hydrochloric acid was poured in.  How would 
this error affect the final result for the heat of formation of magnesium oxide? 

4.  List the important sources of error in this experiment and explain what effect 
each would have on the results.  Discuss in particular any errors which you 
may have made. 

 


